
사용 설명서
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 DGSHAPE Corporation 은 TPL Group 으로부터 MMP 기술 라이센스를 취득했습니다 .

본 제품을 구입해 주셔서 감사합니다 .
•	제품 성능의 완전한 이해와 안전하고 정확한 사용을 위해 본 사용 설명서를 자세히 읽으신 후 안전한 장소에 보관

하십시오 .
•	본 제품을 구매하신 후 공급업체의 도장과 주소 , 구매 날짜가 모두 보증서에 명시되어 있는지 확인한 후 보증서를 

안전한 장소에 보관하십시오 .
•	본 문서의 내용 전체 또는 일부를 동의없이 복사 및 복제하는 것은 금지되어 있습니다 .
•	본 문서의 내용과 본 제품의 사양은 사전 통보없이 변경될 수 있습니다 .
•	본 제품과 본 문서와 관련하여 의심스러운 부분 , 오류나 누락된 부분이 있다면 Roland DG Corporation 에 문의

하십시오 .
•	DGSHAPE Corporation 은 제품의 오작동과 상관없이 본 제품의 사용으로 발생할 수 있는 직접적인 또는 간접적

인 손상에 대해 책임지지 않습니다 .
•	DGSHAPE Corporation 은 본 제품으로 제작된 물품으로 인해 발생할 수 있는 직접적인 또는 간접적인 손상에 

대해 책임지지 않습니다 .

Windows® 는 미국 및 / 또는 기타 국가에서 Microsoft® Corporation 의 상표 또는 등록 상표입니다 .
회사명과 제품명은 해당 소유자의 상표 또는 등록 상표입니다 .

Copyright © 2017-2018 DGSHAPE Corporation

 http://www.dgshape.com/ 
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본 장비에 대하여

특징

본 기기는 레이저 광을 사용하는 열간스탬핑 프린터입니다 . Foil( 포일 ) 을 사용해서 삽화와 텍스트를 
인쇄하여 플라스틱 제품에 품격있는 장식을 새깁니다 .
전용 소프트웨어를 사용하여 쉽게 인쇄 데이터를 만들 수 있습니다 . 

부품 이름 

장비

커버를 열 때는 커버의 가운데  
부분을 잡습니다 .

커버

헤드

헤드부분

전원 / 이동 버튼

레이저 포인터 버튼

전원선 커넥터

USB 커넥터

6 제 1 장 시작하기
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헤드

렌즈에서 조사된 레이저 광을 통해 포일을 자재로 전사시킵니다 . 렌즈는 소모 부품이기 때문에 적
정 시기에 교체해야 합니다 . 
�	P.46 “렌즈 서비스 수명 확인하기	 ”

렌즈

소재 고정장치

센터 바이스

플라스틱으로 만든 바이스로 , 자재를 클램핑해서 고정시킵니다 . 바닥이 곡선으로 된 물건 등 , 접
착 시트로 고정되지 않는 자재를 고정시키는 역할을 합니다 . 

""  P.28 “소재 셋팅 ( 센터 바이스 사용 )”

그리드 테이블

테이블에 자재를 고정시키는 용도로 사용됩니다 . 접착 시트에 고정시킬 자재를 놓습니다 . 기존에 
상용되는 테이프를 사용하지 않고 자재를 . 고정시킬 수 있습니다 .

"" P.32 “소재 셋팅 ( 그리드 테이블 사용 )”

그리드 테이블

접착 시트

본 장비에 대하여

7제 1 장 시작하기
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Light-absorbing Film( 광흡수 필름 )

광흡수 필름에 레이저 광을 가하면 빛이 열로 변환됩니다 . 필름의 앞면과 뒷면이 거꾸로 설치된 상태에
서는 빛이 열로 변환되지 않기 때문에 인쇄가 불가능합니다 . 자세한 내용을  P.47
 “Light-absorbing Film ( 광흡수 필름 ) 교체하기” 를 참조 바랍니다 . 

이 열로 포일이 소재에 전사됩니다 .

A
A 소재

레이저 광

포일

Light-absorbing film
( 광흡수 필름 )

필름 고정장치

필름 리테이너의 바닥에 접착된 접착 시트는 광흡수 필름을 고정시키는 역할을 합니다 . 

핸들

필름 프레임

캡 나사

본 장비에 대하여

8 제 1 장 시작하기

LD-80_USE_Ko.indb   8 2018-08-19   오전 10:11:25



기본 작동법

전원 켜기

순서

[Power/Movement] 버튼을 누릅니다 .
헤드가 왼쪽 뒤로 이동하고 , Power/Movement 버튼의 램프가 켜집니다 . 이 작업을 초기화라고 
합니다 .

중요 : 전원 램프가 계속 깜박일 때

초기화 오류가 발생했습니다 . 아래 섹션을 참조하여 오류의 원인을 없애고 다시 [Power/Move-
ment] 버튼을 누릅니다 .

"" P.90 “[Power/Movement] 버튼이 깜박일 때”

전원 끄기

순서

[Power/Movement] 버튼을 1 초 이상 누릅니다 .

불이 꺼지고 전원이 꺼집니다 .

9제 1 장 시작하기
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소프트웨어 시작하기

Windows 10 및 7

1	[Start] 버튼을 클릭합니다 .

2	[All Apps] 을 클릭합니다 . ( 윈도우 7 에서 [All Programs] 또는 [Programs]).

3	[(Name of software to use)] 폴더 아래에 있는 [(Name of software to use)] 
아이콘을 클릭합니다 .

Windows 8.1

1	[Start] 화면에서 ,  을클릭합니다 .

2	[Apps] 화면에서 , [(Name of software to use)] 을클릭합니다 .

소프트웨어 도움말 보기

소프트웨어를 시작한 후 , 메뉴에서 [Help] → [Contents] 을 선택합니다 .
"" P.10 “소프트웨어 시작하기”

기본 작동법

10 제 1 장 시작하기
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인쇄 워크플로우 체크하기

P.13 “METAZAStudio 에서 출력 제품 선택하기”

장비의 전원을 켠 후 , 컴퓨터의 출력 목적지로 선택합니다 .

P.14 “재료 준비하기”

소재 타입과 두께 등 , 소재에 인쇄하기 위해 충족해야 할 몇가지 조건을 확인합니다 .

P.16 “인쇄 데이터 만들기”

METAZAStudio 를 사용해 인쇄할 데이터를 만듭니다 .

P.28 “소재 셋팅 ( 센터 바이스 사용 )”

P.32 “소재 셋팅 ( 그리드 테이블 사용 )”

장비에 소재를 고정 시킵니다 .

P.36 “인쇄하기”

METAZAStudio 로부터 인쇄 데이터를 출력합니다 .

인쇄 준비하기

12 제 2 장 인쇄하기
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METAZAStudio 에서 출력 제품 선택하기

순서

A	장비 전원을 켭니다 .
"" P.9 “전원 켜기”

B	METAZAStudio 를 시작합니다 .
"" P.16 “METAZAStudio 시작하기”

C	[File] → [Set up the printer] 을 클릭합니다 .

[Print Setup] 을화면이 나타납니다 .

D	데이터를 출력시킬 프린터를 선택합니다 .

1	[DGSHAPE LD-80] 을 선택합니다 .

2	[OK] 를 클릭합니다 .

인쇄 준비하기

13제 2 장 인쇄하기
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재료 준비하기

본 장비로 인쇄할 소재는 아래의 조건을 모두 충족시켜야 합니다 .

소재

•	Acrylic

•	Polycarbonate

•	Polypropylene

•	Polystyrene

•	ABS

두께

최대 : 20 mm (0.8 in.)

크기

소재는 단단히 고정할 수 있을 정도의 크기여야 합니다 .

본 장비는 센터 바이스 또는 접착 시트를 사용해서 소재를 고정시킬수 있습니다 . 센터 바이스나 접착 
시트로부터 돌출하는 크기의 소재도 사용할 수 있지만 , 반드시 소재가 견고하게 고정될 수 있어야 합니
다 .

모양

인쇄할 표면에 울퉁불퉁함이 없어야 합니다 .

고정시켰을 때 , 또는 인쇄 중에 장비의 움직이는 부분과 접촉하는 소재는 인쇄가 불가능합니다 .

소재의 가장자리가 너무 

높습니다 .

L 모양

평면 :

                    단면 :

NOT OK NOT OK

인쇄 준비하기
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그리드 테이블을 사용할 때는 뒷면이 평평하고 레벨에 차이가 없어야 합니다 .

뒷면이 평면이 아닌 소재는 센터 바이스를 사용하여 소재를 고정합니다 .

뒷면이 곡선입니다 . 뒷면이 울퉁불퉁합
니다 .

평면 :

단면 :

OK NOT OK NOT OK

곡면 인쇄를 할 소재의 조건

아래 표와 그림은 연장된 곡면이 있는 원통의 지름에 따른 권장 인쇄 영역을 나타냅니다 . 단 , 다음과 같
은 조건이 가정됩니다 .

곡면이 연장된 재질은 순환성이 있어야 합니다 .

연장된 곡면이 있는 원통의 지름 
(ϕ) 권장 인쇄 영역 (A)

10 mm (0.4 in.) 2.0 mm (0.08 in.)
20 mm (0.8 in.) 2.8 mm (0.11 in.)
30 mm (1.2 in.) 3.4 mm (0.14 in.) 

인쇄 준비하기
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METAZAStudio 시작하기

Windows 10 및 7

1	[Start] 버튼을 클릭합니다 .

2	[All Apps] 을 클릭합니다 . ( 윈도우 7 에서 [All Programs] 또는 [Programs]).

3	[Roland METAZAStudio] 폴더 아래에 있는 [METAZAStudio] 아이콘을 클릭합니
다 .

Windows 8.1

1	[Start] 화면에서 ,  을 클릭합니다 .

2	[Apps] 화면에서 , [METAZAStudio] 을 클릭합니다 .

METAZAStudio 가 실행됩니다 .

인쇄 데이터 만들기
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METAZAStudio 화면

No. 이름 기능

1 Menu bar
METAZAStudio 의 여러 명령을 실행합니다 .

""METAZAStudio 온라인 도움말  ( “Commands” )

2 Toolbar
[Material] 와 [Open] 같이 METAZAStudio 명령을 실행하기 위한 버튼을 제공합니다 .

""METAZAStudio 온라인 도움말 ( “Commands” - “Toolbar buttons” )

3 Page feed bar

가변 필드에 데이터를 입력했을 때 , 화면에 표시되는 페이지 ( 레코드 ) 를 지정하는 역할입
니다 . 가변 인쇄를 할 때 사용합니다 . 

"" P.73 “가변 인쇄 데이터 만들기”

""METAZAStudio 온라인 도움말 ( “Hints and Tips” > “가변 인쇄 실행하기” )

4 Status bar

커서의 현재 위치 , 도형에 대한 정보 , 그리드 정보 , 보기 배율 정보를 표시합니다 . 도구바 
버튼이나 메뉴 명령으로 포인터를 움직이면 버튼이나 명령에 대한 간단한 설명이 왼쪽 가장
자리에 나타납니다 .

Present cursor 
position( 현재 커서 위치 )

커서의 현재 위치를 나타냅니다 . 두 중앙선이 교차하는 창 중
앙의 위치는 (0, 0) 입니다 .

Shape information
( 도형 정보 )

화면에 있는 오브젝트 ( 이미지 , 텍스트 또는 도형 ) 을 클릭하
면 나타납니다 . 아래의 그림과 같이 현재 도형의 중앙 위치와 
크기가 표시됩니다 .

Grid pitch
( 그리드 피치 )

그리드 선의 피치 ( 간격 ) 을 나타냅니다 . 이 버튼을 클릭하면 
그리드에 대한 메뉴 항목들을 볼 수 있습니다 .

View scaling factor
( 보기 배율 계수 )

화면 보기의 현재 배율 계수를 나타냅니다 . 이 버튼을 클릭하
면 보기 배율 계수를 변경할 수 있습니다 .

인쇄 데이터 만들기
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LD-80_USE_Ko.indb   17 2018-08-19   오전 10:11:26



No. 이름 기능

5
Grid table
( 그리드 테이블 )

장비의 그리드 테이블이 표시됩니다 . 표시된 눈금은 그리드 테이블에 있는 실제 눈금을 나
타냅니다 .

6 Work area
( 작업 영역 )

인쇄 가능한 영역입니다 . METAZA 드라이버로 설정된 소재 크기가 여기 표시됩니다 . 

"" P.86 “기본 드라이버 설정 변경하기”

7 Center line
( 중앙선 )

화면의 가로와 세로 중앙선들을 나타냅니다 .

8 Grid( 그리드 )
작업 영역에 표시되는 그리드입니다 . 이미지와 텍스트의 위치를 결정하는 가이드 역할을 
합니다 . 

9 Margin( 여백 )

이 빈 영역은 작업 영역의 가장자리 안쪽이며 인쇄가 되지 않습니다 . METAZAStudio 를 
설치하면 기본 여백 설정은 1 mm (0.04 in.) 입니다 .  여백의 크기는 [File ] 메뉴에서 
[Preferences] 을 선택하면 변경할 수 있습니다 .

"" P.19 “1 단계 : 소재의 모양과 크기 정하기”

인쇄 데이터 만들기
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1 단계 : 소재의 모양과 크기

METAZAStudio 에는 다양한 소재들이 사전 등록되어 있습니다 . 본 섹션은 아래의 플레이트와 같은 
모양의 “tag” ( 태그 ) 라는 이름의 소재를 예시로 설명합니다 .

"" P.14 “재료 준비하기”

25 mm 
(0.98 in.) 

40 mm 
(1.6 in.)

메모

새로운 소재를 등록하려면 아래 항목을 참조 바랍니다 .
"" P.83 “다양한 소재 등록하기”

순서

A	METAZAStudio 를 시작합니다 .
"" P.16 “METAZAStudio 시작하기”

B	 을 클릭합니다 .

[Select Foil] 화면이 나타납니다 .

인쇄 데이터 만들기
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C	[Select Foil] 화면에서 포일을 선택합니다 .
[Use printer driver settings] 체크 박스를 해제해서 포일을 선택합니다 . 목록에 없는 포일을 사
용하려면 포일을 등록합니다 .

"" P.84 “Foil ( 포일 ) 등록 및 인쇄력 조정하기”

METAZA 드라이버 설정을 변경없이 사용하려면 [Use printer driver settings] 체크 박스를 선
택합니다 .

D	[OK] 을 클릭합니다 .

E	 을 클릭합니다 .

[Material] 패널이 나타납니다 .

인쇄 데이터 만들기
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F	소재의 모양을 선택합니다 .

1	“tag” 이름의 아이콘을 클릭합니다 .

2	 을 클릭합니다 .

[Material Size] 화면이 나타납니다 .

3	소재 크기의 값을 입력합니다 .

4	[OK] 을 클릭합니다 .

인쇄 데이터 만들기
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선택된 소재는 Edit ( 편집 ) 화면에 나타납니다 . 소재로 표시된 부분이 인쇄 영역이 됩니다 .

G	[File] → [Preferences] 을 클릭합니다 .

[Preferences] 화면이 나타납니다 .

인쇄 데이터 만들기
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H	여백을 설정합니다 .

1	“Margin( 여백 )” 을 “1 mm” (0.04 in.) 로 설정합니다 .

2	[OK] 을 클릭합니다 .

중요 !

평면 소재에 인쇄할 경우 최소 1 mm (0.04 in.) 의 여백이 필요합니다 . 1 mm (0.04 in.) 미만의 여
백의 경우 소재의 가장자리에 렌즈가 부딪혀 렌즈가 손상될 수 있습니다 . 

인쇄 데이터 만들기
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2 단계 : 이미지 불러오기

인쇄할 이미지를 불러옵니다 .

METAZAStudio 가 지원하는 데이터 포맷

•	JPEG 포맷

•	BMP (bitmap) 포맷

•	Illustrator 버전 7 또는 8 로 생성된 AI 또는 EPS 포맷

•	CorelDRAW 버전 7 또는 8 로 내보낸 AI 또는 EPS 포맷

*	 Illustrator 와 CorelDRAW 파일은 제한이 있습니다 . 자세한 내용은 METAZAStudio 의 온라

인 도움말을 참조 바랍니다 . 
""METAZAStudio 온라인 도움말 ( “Hints 와 Tips” > “Reusing Existing Data” )

중요 : 본 장비는 사진 인쇄에 적합하지 않습니다 .

이미지와 텍스트 데이터를 불러옵니다 .

순서

A	 을 클릭합니다 .

[Import] 화면이 나타납니다 .

B	파일을 엽니다 .

1	[Look in] 에서 파일의 위치를 선택합니다 .

2	[Files of type] 에서 , [Picture file] 또는 [Adobe Illustrator file] 을 선택합니다 .

3	원하는 파일을 선택합니다 .

4	[Open] 을 클릭합니다 .
  

인쇄 데이터 만들기
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지정된 이미지는 설정된 여백과 함께 표시됩니다 .

메모

크기나 방향을 변경하거나 테두리를 추가하는 등 이미지의 배열을 변경할 수 있습니다 .
""METAZAStudio 온라인 도움말  ( “Hints 와 Tips” )

중요 !

소재에 구멍이 있는 경우 , 구멍 위에 이미지가 놓이지 않도록 주의합니다 . 인쇄 영역에 구멍이 있으면 
렌즈가 소재 가장자리에 부딪쳐서 렌즈가 손상될 수 있습니다 .

인쇄 영역 인쇄 영역

인쇄 영역

인쇄 영역

인쇄 영역에 구멍이 있
습니다 .

소재 가장자리에 여백이 
없습니다 .

인쇄 영역이 소재를 넘어
서 설정되있습니다 .

OK Not OK Not OK Not OK

1 mm 
(0.04 in.)

1 mm 
(0.04 in.)

인쇄 데이터 만들기
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3 단계 : 텍스트 입력하기

인쇄할 텍스트를 입력합니다 .

순서

A	 을 클릭합니다 .

B	텍스트를 입력합니다 .

1	인쇄 영역을 클릭합니다 .

2	텍스트를 입력 합니다 .
입력한 텍스트의 크기와 방향을 변경할 수 있고 채우기도 가능합니다 .

""METAZAStudio 온라인 도움말  ( “Hints 와 Tips” )

인쇄 데이터 만들기
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4 단계 : 인쇄 데이터 저장하기

인쇄 데이터를 파일로 저장합니다 .

순서

A	 을 클릭합니다 .

[Save As] 화면이 나타납니다 .

1	[Save in] 에 파일을 저장할 위치를 선택합니다 .

2	파일명을 입력합니다 .

3	[Save] 을 클릭합니다 .

인쇄 데이터 만들기
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인쇄하기

소재 고정장치 선택하기

소재의 크기와 모양에 따라 고정장치로 센터 바이스를 사용할지 그리드 테이블을 사용할지 결정합니
다 . 선택 기준은 다음과 같습니다 :

•	Center vise ( 센터 바이스 ): 센터 바이스로 고정할 수 있는 크기와 모양의 소재 .

•	Grid table ( 그리드 테이블 ): 평평한 바닥으로 센터 바이스로는 고정할 수 없는 크기와 모양의 소재 .

소재 셋팅 ( 센터 바이스 사용 )

1.	 센터 바이스에 소재를 고정합니다 .
그리드 테이블을 사용할 때는 P.32 “1. 그리드 테이블에 소재를 고정합니다 .” .

A	커버를 엽니다 .

B	필름 고정장치의 핸들를 왼쪽으로 돌립니다 .

여기를 잡습니다 .

28 제 2 장 인쇄하기
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C	베이스 테이블에 센터 바이스를 장착합니다 .
센터 바이스 바닥에 있는 돌출부를 베이스 테이블의 구멍에 맞춰 넣습니다 .

센터 바이스

D	소재의 크기와 모양에 따라 바이스를 재설정합니다 .
바이스의 방향과 앞면과 뒷면도 변경할 수 있습니다 . 소재의 크기와 모양에 맞게 사용할 수 있습니다 .

"" P.107 “센터 바이스  사양 ”

원통형의 소재를 클램핑하기에 적합합니다 .접시 모양의 소재를 클램핑하기에 적합합니다 .

바이스

인쇄하기
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E	레이저 포인터 버튼을 누릅니다 .
레이저 광은 레이저 포인터에서 조사됩니다 .
장비가 5 분동안 사용되지 않으면 레이저 포인터는 자동으로 꺼집니다 .

F	METAZAStudio 의 “인쇄 데이터 위치”와 “작업 영역의 중앙”의 위치 관계가 “인쇄 위치”

와 “레이저 포인터” 의 위치 관계와 일치하도록 센터 바이스를 이용해 소재를 고정시킵니
다 .

메모

레이저 포인터가 가르키는 위치와 METAZAStudio 상 작업 영역의 중앙과 일치합니다 . 레이저 포
인터의 위치와 인쇄할 영역의 중앙을 일치시키면 METAZAStudio 작업 영역에 표시된 배치와 동
일한 배치로 인쇄할 수 있습니다 .

작업 영역의 중앙

METAZAStudio

인쇄 데이터 위치

소재

레이저 포인터

인쇄 위치

중요 !

인쇄할 표면의 먼지와 흙을 제거합니다 .

인쇄할 표면에 붙어있는 먼지와 흙을 제거하지 않고 인쇄를 수행하면 인쇄 품질이 저하될 수 있습니다 . 
인쇄 전에 반드시 인쇄할 표면의 먼지와 흙을 제거합니다 .

인쇄하기
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G	바이스를 고정장치 나사로 조여줍니다 .
소재가 쉽게 느슨해지지 않도록 고정장치 나사를 조여줍니다 . 과도하게 조이면 소재가 손상될 수 
있습니다 .

고정장치 나사

바이스

2.	 소재 위에 포일을 놓고 광흡수 필름으로 덮습니다 .

A	소재 위에 포일을 놓습니다 .

중요 !

포일에는 앞면과 뒷면이 있습니다 .

인쇄하고 싶은 포일 색이 위를 향하게 하고 포일을 소재 위에 놓습니다 .

인쇄하기
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B	필름 고정장치 핸들을 오른쪽으로 돌린 후 , 고정장치를 천천히 내립니다 . 
광흡수 필름이 인쇄 범위를 덮을수 있도록 고정시킵니다 .

중요 : 포일로 덮힌 소재에 광흡수 필름을 부착합니다 .

광흡수 필름이 소재에 부착되지 않으면 포일이 성공적으로 전사되지 않습니다 .

중요 : 레이저가 닿는 위치를 바꾸면서 광흡수 필름을 사용합니다 .

동일한 위치를 여러번 사용하면 빛을 열로 변환하는 효과가 감소합니다 . 사용되지 않는 위치가 사
용되도록 자리를 이동하면서 광흡수 필름을 사용합니다 . 더 이상 사용되지 않은 위치가 없으면 광
흡수 필름을 교체합니다 .

"" P.47 “광흡수 필름 서비스 수명의 기본 가이드”

C	커버를 닫습니다 .
"" P.36 “인쇄하기”

소재 셋팅 ( 그리드 테이블 사용 )

1.	 그리드 테이블에 소재를 고정합니다 .
센터 바이스를 사용할 경우 , P.28 “1. 센터 바이스에 소재를 고정합니다 .” 를 참조 바랍니다 .

A	커버를 엽니다 .

인쇄하기
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B	필름 고정장치의 핸들을 왼쪽으로 돌립니다 .

여기를 잡습니다 .

C	베이스 테이블에 그리드 테이블을 장착합니다 .
그리드 테이블 바닥에 있는 돌출부를 베이스 테이블의 구멍에 맞춰 넣습니다 .

그리드 테이블

D	그리드 테이블에 접착 시트를 부착합니다 .

그리드 테이블

그리드 테이블을 위한 접착 시트

접착 시트를 눈금과 정렬해서 그리드 테이블 프레임에 똑바로 놓습니다 . 그리드 테이블과 접착 시
트 사이에 기포가 생기지 않도록 주의합니다 .

메모

접착력이 감소된 경우에는 접착 시트를 닦습니다 . 접착 시트를 닦아야 하는 경우 , 너무 세게 문질러서 
표면이 손상되거나 접착력이 떨어지지 않도록 주의합니다 .

"" P.42 “접착 시트  청소하기”

인쇄하기
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E	레이저 포인터 버튼을 누릅니다 .
장비가 5 분동안 사용되지 않으면 레이저 포인터는 자동으로 꺼집니다 .

레이저 포인터 버튼

F	접착 시트 위에 소재를 고정시킵니다 .

레이저 포인터

소재

•	 METAZAStudio 의 “인쇄 데이터 위치” 와 “작업 영역의 중앙” 의 위치 관계가 “인쇄 
위치” 와 “레이저 포인터” 의 위치 관계와 일치하도록 소재를 고정시킵니다 .

작업 영역의 중앙

METAZAStudio

인쇄 데이터 위치

소재

레이저 포인터

인쇄 위치

•	 접착 시트에 부착하듯 소재를 부드럽게 누릅니다 .

메모

레이저 포인터가 가르키는 위치와 METAZAStudio 상 작업 영역의 중앙과 일치합니다 . 레이저 포인
터의 위치와 인쇄할 영역의 중앙을 일치시키면 METAZAStudio 작업 영역에 표시된 배치와 동일한 배
치로 인쇄할 수 있습니다 .

인쇄하기
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소재 놓는 방법

•	 METAZAStudio 작업 영역의 중앙이 그리드 테이블 눈금의 중앙으로 오도록 소재를 
배치합니다 . 

•	 소재가 너무 커서 그리드 테이블에 맞지 않으면 , 지지대를 이용해서 소재를 수평으로 
유지합니다 .

접착 시트METAZAStudio 
작업 영역 중앙

접착 

접착 시트

접착 시트

중요 : 인쇄할 표면의 먼지와 흙을 제거합니다 .

인쇄할 표면에 붙어있는 먼지와 흙을 제거하지 않고 인쇄를 수행하면 인쇄 품질이 저하될 수 있습니다 . 
인쇄 전에 반드시 인쇄할 표면의 먼지와 흙을 제거합니다 .

2.	 소재 위에 포일을 놓고 광흡수 필름으로 덮습니다 .

A	소재 위에 포일을 놓습니다 .

중요 !

포일에는 앞면과 뒷면이 있습니다 .

인쇄하고 싶은 포일 색이 위를 향하게 하고 포일을 소재 위에 놓습니다 .

인쇄하기
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B	필름 고정장치 핸들을 오른쪽으로 돌린 후 , 고정장치를 천천히 내립니다 . .
광흡수 필름이 인쇄 범위를 덮을수 있도록 고정시킵니다 .

중요 : 포일로 덮힌 소재에 광흡수 필름을 부착합니다 .

광흡수 필름이 소재에 부착되지 않으면 포일이 성공적으로 전사되지 않습니다 .

중요 : 레이저가 닿는 위치를 바꾸면서 광흡수 필름을 사용합니다 .

동일한 위치를 여러번 사용하면 빛을 열로 변환하는 효과가 감소합니다 . 사용되지 않는 위치가 사
용되도록 자리를 이동하면서 광흡수 필름을 사용합니다 . 더 이상 사용되지 않은 위치가 없으면 광
흡수 필름을 교체합니다 .

"" P.47 “광흡수 필름 서비스 수명의 기본 가이드”

C	커버를 닫습니다 .
"" P.36 “인쇄하기”

인쇄하기

“인쇄 데이터 만들기” 와 “소재 고정하기” 가 끝나면 인쇄를 시작합니다 .
"" P.16 “인쇄 데이터 만들기” , P.14 “재료 준비하기”

순서

A	 을 클릭합니다 .
[Print] 화면이 나타납니다 .

인쇄하기
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B	아래와 같이 설정을 하고 확인합니다 .

Name( 이름 ) DGSHAPE LD-80

Foil( 포일 ) 포일을 선택합니다 . 새로운 인쇄 데이터를 생성할 때 정한 선택이 포일 설정에 반
영됩니다 .

Print Range
( 인쇄 범위 )

가변 인쇄를 할 때 주로 쓰는 옵션입니다 . ( 일반적으로 [All] 가 선택되어 있습니
다 .) 인쇄할 레코드를 제한하려면 인쇄할 레코드 ( 페이지 ) 를 지정합니다 . 예를 
들어 , 2 번째에서 5 번째 레코드만 인쇄하려면 [Pages ] 를 선택한 후 , 페이지 
” 2” 에서 페이지 “5” 까지 지정합니다 .

Copies( 개수 ) 동일한 소재의 여러 위치에 인쇄를 하는 경우 , 개수를 지정합니다 . 예를 들어 , 소
재의 앞면과 뒷면에 인쇄하려면 개수에 “2” 를 지정합니다 .

*	  Record: 가변 인쇄 데이터에 포함되어 있는 개별 데이터를 칭합니다 .
"" P.73 “가변 인쇄 데이터 만들기”

C	[OK] 을 클릭합니다 .
인쇄가 시작됩니다 .

메모 : 여러 개수 또는 레코드 인쇄하기

인쇄가 시작되면 아래 그림과 같은 메세지가 나타납니다 . 인쇄가 완료될 때까지 기다린 
후 , 다음 단계로 진행합니다 .

중요 : 인쇄 중에는 절대 커버를 열지 않습니다 .

인쇄 중에 커버가 열리면 인쇄가 중단되어 정확한 인쇄가 불가능하게 됩니다 .

인쇄하기
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D	인쇄가 완료되면 소재를 교체하거나 방향을 바꿔줍니다 .
"" P.28 “소재 셋팅 ( 센터 바이스 사용 )”

"" P.32 “소재 셋팅 ( 그리드 테이블 사용 )”

중요 !

소재를 교체할 때마나 레이저 포인터 버튼으로 위치를 정렬합니다 .

E	[OK] 을 클릭합니다 .
다음 페이지의 인쇄가 시작됩니다 .

표시된 레코드만 가변 인쇄하기

 을 클릭합니다 .
[Print] 화면이 나타납니다 .
METAZAStudio 에 표시되고 있는 레코드의 번호 ( 페이지 번호 ) 가 [Print Range] 아래에 페이
지로 지정됩니다 . 필요에 따라 [Foil] 과 [Copies] 를 지정하고 [OK] 를 클릭해 인쇄를 시작합니
다 .

인쇄하기
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1단계 : 인쇄 작업 멈추기

A	Power/Movement ( 전원 / 이동 ) 버튼을 1 초 이상 누릅니다 .
전송된 인쇄 데이터가 삭제되는 동안 불빛이 천천히 깜박입니다 . 불이 꺼지고 전원이 꺼집니다 .

메모

인쇄를 일시정지하면 헤드가 같은 위치를 유지합니다 . 다음번에 전원이 켜지면 헤드는 왼쪽 뒤로 이동
합니다 .

인쇄 작업 멈추기
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2 단계 : 인쇄 대기열에서 데이터 삭제하기 

순서

A	프린터 아이콘이 표시됩니다 .

Windows 10 및 8.1

1	컴퓨터의 [ 시작 ] 메뉴에서 마우스 우측버튼을 클릭합니다 .

2	[ 제어판 ] 을 클릭합니다 .

3	[ 장치와 프린터 ] 를 클릭합니다 .
Windows 7

1	[Start] 메뉴를 클릭합니다 .

2	[ 장치와 프린터 ] 를 클릭합니다 .

B	[DGSHAPE LD-80] 아이콘을 더블클릭합니다 .

C	[ 프린터 ] 메뉴에서 , [Cancel All Documents] ( 또는 [Purge Print Documents])

를 클릭합니다 .

D	다음과 같은 메세지가 나타나면 [Yes] 를 클릭합니다

인쇄 작업 멈추기
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제 3 장 보수유지 및 조정하기
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일상 관리 시 주의할 점

 주의             	 휘발유 , 알콜 , 시너 등 인화성 물질은 절대 사용하지 마십시오 .
화재의 위험이 있습니다 .

 주의      	 수리 , 부품 교체와 같은 작업 중 , 본 사용 설명서에 없는 작업은 절대 수행하지

                                       마십시오 . 

                                     Roland DG Corporation 딜러에 문의합니다 .

 주의       	 본 작업은 모든 전원 스위치를 끄고 작업하십시오 .
장비의 갑작스런 작동으로 인한 부상의 위험이 있습니다 .

•	본 장비는 정밀 장비며 먼지와 흙에 민감합니다 . 매일 청소가 필요합니다 .

•	시너 , 벤젠 또는 알콜과 같은 용액은 절대 사용하지 마십시오 .

•	장비에 기름이나 윤활유를 절대 바르지 마십시오 .

•	장비에 실리콘 물질 ( 기름 , 그리스 , 스프레이 등 ) 을 절대 사용하지 마십시오 . 스위치 접촉 불량의 원
인이 될 수 있습니다 .

본체 / 센터 바이스 / 그리드 테이블 청소하기

•	물에 적셔서 꼬옥 짠  천으로 부품을 부드럽게 닦습니다 .

•	커버의 표면은 쉽게 긁히기 때문에 부드러운 천을 사용합니다 .

접착 시트 청소하기

그리드 테이블의 접착 시트에 먼지 등이 쌓이면 시트의 접착력이 저하되어 소재를 고정하기 어려워집니
다 . 접착력이 저하된 경우 , 접착 시트를 닦습니다 .

접착 시트

일상 관리
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접착 시트 닦기

접착 시트를 물에 완전히 담근 상태에서 표면을 부드럽게 문질러 닦습니다 . 접착 시트의 오염이 심한 
경우 , 희석된 중성 세제를 사용합니다 . 물로 완전히 헹구어 모든 세제를 제거합니다 . 

중요 !

반드시 아래의 지침을 준수하십시오 . 그렇지 않을 경우 , 접착 시트의 표면이 손상되어 접착력이 저하
될 수 있습니다 .

•	절대 스크러빙 패드 또는 스폰지를 사용하여 접착 시트를 문지르지 마십시오 .

•	닦는 중에 절대 접착 시트를 늘리거나 구부리지 마십시오 .

접착 시트 건조시키기

직사광선을 피해 부품을 완전히 건조시킵니다 .

필름 고정장치 청소하기

접착 시트의 필름 프레임에 먼지 등이 쌓이면 시트의 접착력이 저하되어 광흡수 필름을 고정할 수 없습
니다 . 접착력이 저하된 경우 , 접착 시트의 필름 프레임을 닦습니다 .

접착 시트

필름 고정장치 닦기

접착 시트를 물에 완전히 담근 상태에서 표면을 부드럽게 문질러 닦습니다 . 접착 시트의 오염이 심한 
경우 , 희석된 중성 세제를 사용합니다 . 물로 완전히 헹구어 모든 세제를 제거합니다 .

중요 !

반드시 아래의 지침을 준수하십시오 . 그렇지 않을 경우 , 접착 시트의 표면이 손상되어 접착력이 저하
될 수 있습니다 .

•	절대 스크러빙 패드 또는 스폰지를 사용하여 접착 시트를 문지르지 마십시오 .

•	닦는 중에 절대 접착 시트를 늘리거나 구부리지 마십시오 .

필름 고정장치 건조시키기

직사광선을 피해 부품을 완전히 건조시킵니다 .

일상 관리

43제 3 장 보수유지 및 조정하기

LD-80_USE_Ko.indb   43 2018-08-19   오전 10:11:30



원점 위치 조정하기

인쇄된 텍스트나 이미지의 위치가 원하던 위치와 일치하지 않으면 장비의 원점이 잘못 맞추어져 있기 
때문입니다 . 아래의 설명을 따라 원점의 위치를 조정합니다 . 렌즈를 교체할 때에도 원점 위치를 조정
해야 합니다 .

순서

A	 LD-80 헤드매니저를 시작합니다 .
"" P.10 “소프트웨어 시작하기”

B	[Adjust Origin] 를 클릭합니다 .

[Adjust Origin] 이 화면에 나타납니다 .
화면에 나오는 지시를 따라 조정을 수행합니다 .

반드시 센터 바이스를 사용합니다 .

그리드 테이블을 사용할 경우 , 소재가 작업 중에 잘못 정렬되어 원점 조정이 실패할 수 있습니다 .

조정하기
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C	 완료 후   를 클릭합니다 .
창을 닫습니다 .

조정하기
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소모품 교체하기

렌즈 서비스 수명 확인하기

렌즈는 소모 부품입니다 . 서비스 수명이 끝난 렌즈는 교체합니다 .

렌즈 서비스 수명에 대한 기본 가이드

렌즈의 교체 가이드라인은 약 500 시간의 인쇄 후 입니다 .
METAZAStudio 에 렌즈 서비스 수명에 대한 메세지가 표시됩니다 .

[OK] 을 클릭하면 메시지가 사라집니다 . [Details] 을 클릭하면 LD-80 헤드매니저가 나타납니다 .

순서

A	LD-80 헤드매니저를 시작합니다 .
"" P.10 “소프트웨어 시작하기”

B	장비 전원을 켭니다 .
"" P.9 “전원 켜기”

렌즈의 사용량이 이 화면에 표시됩니다 . 인쇄가 수행됨에 따라 
레벨 표시기가 조금씩 올라갑니다 . 

최신 정보를 표시하도록 화면을 새로고침합니다 .
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메모

LD-80 헤드매니저의  [The amount of Lens usage] 표시기는 렌즈가 얼마나 사용되었는지 나
타냅니다 . 다음과 같은 경우에는 렌즈를 교체해야 합니다 .

•	표시기가 빨간색일 때 .

•	표시기가 빨간색이지 않지만 인쇄물이 보기에 좋지 않거나 이미지가 고르지 않을 때 .

인쇄 품질의 감소와 고르지 못한 인쇄 결과는 마모된 렌즈때문만은 아닙니다 . 문제의 원인은 아래 
페이지를 참조 바랍니다 . 마모된 렌즈가 유력한 원인이라면 렌즈를 새 것으로 교체합니다 .

"" P.<?> “인쇄된 이미지가 보기 안 좋을 때 ( 울퉁불퉁하거나 위치가 움직였을 때 )”

*	 교체용 렌즈는 별도로 판매됩니다 . 자세한 내용은 공인 Roland DG Corporation 딜러에 문의

하거나 웹사이트를 방문하십시오 (http://www.dgshape.com/).

*	 렌즈 교체 방법은 교체용 렌즈와 동봉된 사용 설명서를 참조 바랍니다 .

Light-absorbing Film ( 광흡수 필름 ) 교체하기

동일한 위치를 여러번 사용하면 빛을 흡수하는 효과가 감소합니다 . 사용되지 않은 위치가 사용되도록 
광흡수 필름의 위치를 이동시켜서 사용합니다 . 더 이상 사용되지 않은 위치가 없을 때에는 광흡수 필름
을 교체합니다

광흡수 필름 서비스 수명에 대한 기본 가이드

광흡수 필름에 반복된 열 발생으로 인한 주름과 물결이 생기거나 흰색으로 변하면 서비스 수명이 다 되
었음을 뜻합니다 . 아래의 그림과 같은 상태가 되면 광흡수 필름을 교체하거나 필름의 위치를 움직여줍
니다

흰색으로 변색된 부분은 빛을 흡수하지 못 하
기 때문에 인쇄에 사용할 수 없습니다 .
 

소모품 교체하기
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Light-absorbing Film ( 광흡수 필름 ) 교체 방법

순서

A	필름 고정장치의 왼쪽 핸들을 들어서 왼쪽으로 돌립니다 .

여기를 잡습니다 .

B	필름 프레임을 제거합니다 .

이 부분을 본인 방향으로 당깁니다 .

풀어줍니다

소모품 교체하기
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1	［ ］ ［ ］ ［ ］ ［ ］

2	［ ］ ［ ］ ［ ］ ［ ］
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C	접착 시트 표면이 위를 향하도록 필름 프레임의 방향을 맞춥니다 .

접착 시트

D	필름 프레임에서 광흡수 필름을 떼어냅니다 .

소모품 교체하기

49제 3 장 보수유지 및 조정하기

LD-80_USE_Ko.indb   49 2018-08-19   오전 10:11:31



E	새로운 광흡수 필름을 부착합니다 .

중요 : 광흡수 필름은 소재면과 렌즈면이 있습니다 . 올바른 쪽은 위로 하여 부착합니다 .

표식이 오른쪽 아래 코너에 
있을 때

소재와 접촉하는 면렌즈와 접촉하는 면

표식이 오른쪽으로 열리면 소재와 접촉하는 면이 
위를 향합니다 .

Light-absorbing Film 
( 광흡수 필름 )

광흡수 필름이 표식이 오른쪽으로 열리면 올바른 방향입니다 . 표식이 오른쪽 아래를 향하고 있으면 
반대면이 위를 향하도록 다시 방향을 잡습니다 .

OK Not  OK
Light-absorbing 
Film ( 광흡수 필름 )

원래 사용하던 광흡수 필름에 사용되지 않은 부분이 남아있다면 필름의 위치를 이동시켜 필름 프레
임에 부착합니다 .

메모

필름 프레임에 부착되는 접착 시트의 접착력이 저하되면 접착 시트를 닦습니다 .
"" P.43 “필름 고정장치 청소하기”

소모품 교체하기
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F	접착 시트의 표면이 아래를 향하도록 필름 프레임의 방향을 맞춥니다 .

표식이 있는 부분이 오
른쪽 위 모서리에 있도
록 방향을 맞춥니다 .

렌즈와 접촉하는 표면

Light-absorbing Film 
( 광흡수 필름 )

소재와 접촉하는 표면

Light-absorbing Film 
( 광흡수 필름 )

G	광흡수 필름을 필름 프레임에 붙인 후 , 필름 프레임을 부착합니다 .
돌출부와 홈이 핸들 지지대와 정렬되도록 필름 프레임을 삽입합니다 .

탭

핸들

H	캡 나사를 조입니다 .

소모품 교체하기
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이미지의 필요한 부분만 남기기 ( 트리밍 )

METAZAStudio 는 원본 이미지를 잘라서 불필요한 부분을 제거하고 필요한 부분만 남길 수 있습니
다 .
이 작업을 ” trimming” ( 트리밍 ) 이라고합니다 .

순서

A	이미지를 불러옵니다 .
"" P.24 “2 단계 : 이미지 불러오기”

B	이미지를 선택합니다 .

1	 을 클릭합니다 .

2	이미지를 클릭합니다 .

8 개의 트리밍 바가 이미지 주위에 나타납니다 .

C	이미지를 잘라냅니다 .
트리밍 바를 드래그하여 원하는 부분을 자릅니다 .

Trimming pointer

이미지 프로세싱
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이미지의 위치 , 크기 또는 각도 조정하기

A	 을 클릭합니다 .

B	이미지의 위치를 조정합니다 .

1	이미지를 클릭합니다 .
이미지의 모서리에 각각 ( ■ ) 가 나타납니다 .

2	이미지를 위치로 드래그해서 조정합니다 .

C	이미지의 크기를 조정합니다 .

1	이미지를 클릭합니다 .
이미지의 모서리에 각각 ( ■ ) 가 나타납니다 .

2	이미지 모서리에 있는 핸들을 드래그해서 크기를 조정합니다 .

Handles

이미지 프로세싱
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D	이미지의 각도를 조정합니다 . 

1	모서리에 4 개의 핸들이 있을 때 이미지를 다시 클릭합니다 .
모서리에 있는 4 개의 핸들 모양이  ( ● ) 로 변합니다 .

2	포인터를 핸들과 정렬합니다 .
회전을 위해 모양이 포인터로 변합니다 .

3	핸들을 드래그해서 이미지의 각도를 조정합니다 .

메모

•	키보드의 SHIFT 키를 누른 상태에서 핸들을 드래그하면 각도가 45 도씩 이동합니다 . 정확히 90 도로 
조정을 하고 싶을 때 이용할 수 있는 간편한 방법입니다 . 

•	각도가 변경된 이미지는 trimming ( 트리밍 ) 을 실행할 수 없습니다 . 잘라내기를 실행하려면 먼저 이
미지를 원래의 각도로 되돌려야 합니다 .

이미지 프로세싱
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테두리로 이미지 둘러싸기

이미지를 테두리로 둘러싸서 인쇄 데이터의 배치를 변경할 수 있습니다 . METAZAStudio 의 “라이브
러리” 에 등록된 프레임을 사용할 수 있습니다 . 라이브러리에는 이미 등록된 프레임이 있고 새로 등록
도 가능합니다 .

""METAZAStudio 온라인 도움말 ( “Hints 와 Tips” > “라이브러리 사용하기” )

순서

A	 을 클릭합니다 .
[Library] 화면이 나타납니다 .

B	프레임을 삽입합니다 .

1	[Group] 에서 , [Frame] 을 선택합니다 .

2	[Icon] 을 클릭합니다 .

3	[18] 프레임을 클릭합니다 .

4	 을 클릭합니다 .
화면에 테두리가 삽입됩니다 .

이미지 프로세싱
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C	프레임의 크기와 위치 조정하기
프레임의 크기가 소재보다 클 경우 , 다음과 같이 됩니다 . 조정 방법은 이미지의 위치와 크기를 조
정하는 방법과 동일합니다 .

"" P.54 “이미지의 위치 , 크기 또는 각도 조정하기”

핸들

이미지 프로세싱
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텍스트 레이아웃을 위한 팁

텍스트의 위치 , 크기 또는 각도 변경하기

이미지와 같이 텍스트도 위치 , 크기와 각도를 변경할 수 있습니다 .

순서

A	텍스트를 입력합니다 .
"" P.26 “3 단계 : 텍스트 입력하기”

B	텍스트 위치를 조정합니다 .

1	 을 클릭합니다 .

2	조정할 텍스트를 클릭합니다 .
텍스트 주위에 8 개의 핸들이 나타납니다 .

3	텍스트를 드래그해서 위치를 조정합니다 .

C	프레임의 크기를 조정합니다 .
핸들을 드래그해서 크기를 조정합니다 .
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D	텍스트의 각도를 조정합니다 .

1	텍스트를 클릭한 후 , 모서리에 있는 4 개의 핸들 모양이 [ ● ] 로 변할 때까지 마우스 
버튼을 누릅니다 .

2	포인터를 핸들과 정렬합니다 .
회전을 위해 모양이 포인터로 변합니다 .

3	핸들을 드래그해서 텍스트의 각도를 조정합니다 .

메모

키보드의 SHIFT 키를 누른 상태에서 핸들을 드래그하면 각도가 45 도씩 이동합니다 . 정확히 90 도로 
조정을 하고 싶을 때 이용할 수 있는 간편한 방법입니다 .

부채꼴 모양으로 텍스트 정렬하기

A	텍스트를 입력합니다 .
"" P.26 “3 단계 : 텍스트 입력하기”

B	 을 클릭합니다 .
[Properties] 화면이 나타납니다 .

텍스트 레이아웃을 위한 팁
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C	텍스트 배열을 설정합니다 .

1	[Format] 탭을 클릭합니다 .

2	[Align with Curve] 체크 박스를 선택합니다 .

3	[OK] 을 클릭합니다 .

텍스트의 배치가 부채꼴 모양으로 변경됩니다 .

텍스트 레이아웃을 위한 팁
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도형을 따라 텍스트 배치하기

드로잉 도구를 이용해 직접 만든 모양을 따라 텍스트를 배치합니다 .

순서

A	도형을 만듭니다 .

1	드로잉 도구를 클릭합니다 .
본 샘플은 를 사용합니다 .

2	편집 화면에서 소재의 모양을 만듭니다 .
""METAZAStudio 온라인 도움말  ( “Commands” - “Toolbar buttons” )

드로잉 도구

B	 을 클릭합니다 .
만든 모양의 외곽선 근처에 포인터를 놓고 , 포인터 밑에   가 나타나면 클릭합니다 .

텍스트 레이아웃을 위한 팁
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C	텍스트를 입력합니다 .
"" P.26 “3 단계 : 텍스트 입력하기”

도형에 따라 텍스트가 배치됩니다 .

중요 !

결합된 폴리라인에는 배치가 불가능합니다 .
""METAZAStudio 온라인 도움말 ( “Commands” > “[Object] 메뉴” > “폴리라인으로 변환하기 ,” “Integrate Poly-

line” )

텍스트 채우기

텍스트 채우기는 두가지 방법이 있습니다 : [Fill] 과 [Island Fill]. 원하는 방법을 선택합니다 . 

Fill
공백없이 인쇄됩니다 .

Island Fill
채움 선들 사이의 간격을 지정할 수 있습니다 .

A	텍스트를 입력합니다 .
"" P.26 “3 단계 : 텍스트 입력하기”

B	 을 클릭합니다 .

텍스트 레이아웃을 위한 팁
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[Properties] 화면이 나타납니다 .

C	Fill 설정을 선택합니다

1	[Fill 과 Contour] 탭을 클릭합니다 .

2	[Fill] 체크 박스를 선택합니다 .

3	[Fill] 또는 [Island Fill] 을 선택합니다 .
[Island Fill] 을 선택할 경우 ,  pitch* 도 입력해야 합니다 .

* Pitch: 채움 선들 사이의 간격

4	[OK] 을 클릭합니다 .
텍스트가 채워집니다 .

텍스트 레이아웃을 위한 팁
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스트로크 캐릭터 와 SFEdit2 에 대하여 

스트로크 캐릭터란 ?

스트로크 캐릭터란 기본 폰트에서 중앙선을 추출해 만든 라인 드로잉입니다 .

SFEdit2 란 ?

SFEdit2 는 스트로크 캐릭터 폰트를 만들고 편집하는 프로그램입니다 . 모든 스트로크 캐릭터는 라인
과 폴리라인으로 구성되어 있기 때문에 , 앵커 포인트를 추가하고 삭제하거나 라인 세그먼트를 추가할 
수 있습니다 . METAZAStudio 에서는 SFEdit2 를 사용해서 스트로크 캐릭터 폰트를 만들고 편집할 
수 있습니다 .

Stroke Character Font 편집 / 제작
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SFEdit2 화면

No. 이름 기능

1 Menu bar
SFEdit2 의 여러 명령을 실행합니다 .

"" SFEdit2 Help 도움말  ( “Commands” )

2 Toolbar
[Open... ] 와 [Save] 같이 SFEdit2 명령을 실행하기 위한 버튼을 제공합니다 .

"" SFEdit2 Help 도움말  ( “Commands” - “Toolbar buttons” )

3 Status bar
도구바 버튼이나 메뉴 명령으로 포인터를 움직이면 버튼이나 명령에 대한 간단한 설명을 표
시합니다 .

4 Character list 모든 스크로크 캐릭터의 목록을 표시합니다 . 스트로크 캐릭터를 편집하려면 클릭합니다 .

5 Base line
텍스트 스트링을 수평으로 정렬하기 위한 기준선입니다 . 텍스트를 가로로 쓰면 양옆의 글
자들이 수평으로 고르게 정렬됩니다 .

6 Text box
텍스트를 두르는 박스입니다 . 베이스 폰트와 글자의 타입에 따라 박스의 크기가 다릅니다 . 
일반적으로 박스 안에 들어갈 수 있도록 텍스트를 만듭니다 .

7 Base font text
스트로크 캐릭터 편집을 위한 대략적인 초안으로 표시됩니다 . 베이스 폰트는 스트로크 캐
릭터의 디자인 베이스로 사용됩니다 .

8 Stroke characters

베이스 폰트에서 중앙선을 추출해 만든 라인 드로잉입니다 . 모든 스트로크 캐릭터는 앵커 
포인트를 추가 / 삭제하거나 라인 세그먼트를 추가해서 편집할 수 있습니다 .

"" SFEdit2 Help 도움말  ( “Operation Procedures” > “2 단계 : 글자 모양 편

집하기”

Stroke Character Font 편집 / 제작
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스트로크 캐릭터 폰트 제작

스트로크 캐릭터 폰트를 만들고 저장하는 방법은 아래와 같습니다 .

순서

A	METAZAStudio 를 시작합니다 .
""  소프트웨어를 시작하는 방법은 셋업 가이드를 참조 바랍니다 .

B	[Edit] → [Stroke Font] → [Run SFEdit2…] 을 클릭합니다 .
SFEdit2 가 시작됩니다 .

C	[File] → [New…] 을 클릭합니다 .
[Select Base Font] 화면이 나타납니다 .

D	스트로크 캐릭터를 만듭니다 .

1	새로 만들 스트로크 캐릭터 폰트의 베이스가 될 폰트를 선택합니다 .

2	[OK] 을 클릭합니다 .

Stroke Character Font 편집 / 제작
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스트로크 캐릭터 폰트가 자동으로 생성되었습니다 .

E	 을 클릭합니다 .

[Save] 화면이 나타납니다 .

F	새로 만든 스트로크 캐릭터 폰트의 이름을 입력하고 저장합니다 .

1	새로 만든 스트로크 캐릭터의 이름을 입력합니다 .
베이스 폰트를 기본으로 새로운 이름을 지으면 나중에 찾기 쉽습니다 . 예로 “Arial2” 를 입력합니
다 .

2	[OK] 을 클릭합니다 .

새로 만든 스트로크 캐릭터 폰트가 저장되었습니다 .

G	 을 클릭합니다 .

Stroke Character Font 편집 / 제작
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입력한 글자를 스트로크 캐릭터 폰트로 변경하기

아래 두가지 작업 중 한가지를 미리 완료하고 절차를 따르십시오 .

SFEdit2 을 설치하기 전에 스트로크 캐릭터 폰트 만들기 .

설치 중 다음과 같은 화면이 나타납니다 . 설치 시 스트로크 캐릭터 폰트를 만들지 않았다면 SFEdit2 를 
재설치하고 스트로크 캐릭터 폰트를 만듭니다 .
"" P.95 “소프트웨어와 전자 사용 설명서를 별도로 설치하기”

새로운 스트로크 캐릭터 폰트 만들기 .

"" P.66 “스트로크 캐릭터 폰트 제작”

순서

A	METAZAStudio 에 글자를 입력합니다 .
"" P.26 “3 단계 : 텍스트 입력하기”

B	 을 클릭합니다 .
[Properties] )] 화면이 나타납니다 .
입력된 글자가 있는 텍스트 박스를 선택하지 않으면 선택이 불가합니다 . 텍스트 박스를 선택했는지 
확인합니다 .

Stroke Character Font 편집 / 제작
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C	스트로크 캐릭터 폰트를 선택합니다 .

1	[Format] 탭을 클릭합니다 .

2	[Stroke] 을 클릭합니다 .
[Font] 의 옵션이 스트로크 캐릭터로 제한됩니다 .

3	스트로크 캐릭터 폰트를 선택합니다 .

4	[OK] 을 클릭합니다 .

입력된 글자는 스트로크 캐릭터로 변경됩니다 . 3 번에서 선택된 스트로크 캐릭터 폰트가 스트로
크 캐릭터에 적용됩니다 .

Stroke Character Font 편집 / 제작
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스트로크 캐릭터 편집하기

순서

A	입력한 글자를 스트로크 캐릭터로 변경합니다 .
"" P.68 “입력한 글자를 스트로크 캐릭터 폰트로 변경하기”

B	스트로크 캐릭터 편집을 시작합니다 .

1	 을 클릭합니다 .

2	편집하고 싶은 스트로크 캐릭터를 클릭합니다 .
스트로크 캐릭터 주위로 6 개의 핸들이 나타납니다 .

3	[Edit] → [Stroke Font] → [Edit Stroke…] 을 클릭합니다 .

SFEdit2 가 시작됩니다 .

C	캐릭터 리스트에서 편집하고 싶은 스트로크 캐릭터를 클릭합니다 .
클릭된 스트로크 캐릭터가 텍스트 박스에 표시되며 , 스트로크 캐릭터를 편집할 수 있게 됩니다 . 스
트로크 캐릭터의 위치와 모양을 변경합니다 . 

"" SFEdit2 Help 도움말 ( “Editing Polylines” )

Character list

Stroke Character Font 편집 / 제작
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D	SFEdit2 를 종료합니다 .

1	 을 클릭합니다 .
선택된 스트로크 캐릭터 폰트는 편집된 수정 사항으로 덮어 쓰워집니다 .

2	 을 클릭합니다 .
SFEdit2 가 종료됩니다 .

편집한 사항들은 스트로크 캐릭터에 반영이 됩니다 .

Stroke Character Font 편집 / 제작
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완성품 확인하기

미리보기 화면을 사용해서 완성품을 확인합니다 .

순서

 을 클릭합니다 .

미리보기 화면이 나타납니다 .
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가변 인쇄 데이터 만들기

인쇄 데이터의 일부를 변경한 후 , 각 소재에 다른 오브젝트를 인쇄하는 기술을 “variable imprinting 
( 가변 인쇄 )” 라고 합니다 . 가변 인쇄를 할 경우 , 새 소재를 고정시킬 때마다 새로운 데이터를 만들 
필요가 없고 중단없이 다른 데이터를 계속 인쇄할 수 있습니다 .

중요 !

다양한 데이터를 사용한 연속 인쇄는 동일한 구성과 크기의 소재로만 수행할 수 있습니다 .

가변 인쇄를 수행하기 위해서는 CSV 파일이 필요합니다 .

CSV 파일은 데이터베이스 파일들을 사용해서 만들 수 있습니다 . CSV 파일을 만드는 방법은 데이터베
이스 관리자에게 문의 바랍니다 .

1 단계 : 가변 필드 만들기

메모 : 가변 필드란 ?

가변 필드는 텍스트를 배치할 수 있는 프레임입니다 . 가변 인쇄 시 , 가변 필드 내의 데이터는 다른 데이
터로 대체됩니다 .

순서

A	METAZAStudio 를 시작합니다 .
""소프트웨어를 시작하는 방법은 셋업 가이드를 참조 바랍니다 .

[Select Foil] 화면에서 포일을 선택합니다 .
METAZAStudio 가 시작되면 , 을 클릭합니다 .

[Select Foil] 화면이 나타납니다 .

B	[Select Foil] 화면을 사용해서 포일을 선택합니다 .
[Use printer driver settings] 체크 박스를 지워서 포일을 선택합니다 . 목록에 없는 포일을 사용
하려면 포일을 등록합니다 .

"" P.84 “포일 등록 및 인쇄력 조정하기”

METAZA 드라이버 설정을 변경없이 사용하려면 , [Use printer driver settings] 체크 박스를 선
택합니다 .

C	[OK] 을 클릭합니다 .
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D	프레임 삽입 아이콘을 클릭합니다 .
  을 클릭한 후 , 을 클릭합니다 .

E	METAZAStudio 의 작업 영역 * 에서 대각선 아래로 마우스를 드래그 ( 마우스의 왼쪽 버

튼을 누른 상태로 이동 ) 합니다 .
텍스트를 입력할 수 있는 가변 필드가 생성됩니다 .
* 작업 영역 = 화면상 검은 영역

작업 영역

가변 인쇄 데이터 만들기
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F	[Object] > [Move to Center] 을 클릭합니다 .

가변 필드의 중앙이 작업 영역의 중앙으로 이동합니다 .

중요 : 이 작업은 실제 인쇄와 연관이 있기 때문에 중요합니다 .

장비에서 인쇄의 중앙점은 인쇄 기준점으로 정의됩니다 . METAZAStudio 에서 “작업 영역의 중앙”
은 인쇄 작업의 기준점을 의미합니다 . 
따라서 “가변 필드의 중앙” 을 작업 영역의 중앙과 일치시키면 “가변 필드의 중앙” 을 “실제 인쇄 작업
의 기준점” 과 일치시키는 것을 의미합니다 . 

가변 필드의 중앙을 “인쇄 작업 기준점” 과 일치시키지 않고도 인쇄 할 수 있지만 , 일치를 시키면 텍스
트와 이미지를 원하는 위치에 쉽게 배치할 수 있습니다 .

가변 인쇄 데이터 만들기
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G	 을 클릭합니다 .
[Properties] 화면이 나타납니다 .

가변 필드를 선택하지 않으면 을 클릭할 수 없습니다 .  을 클릭할 수 없는 경우 ,   를 클릭
( 선택 ) 한 후 가변 필드를 선택 합니다 .

H	가변 필드의 크기를 포함한 속성을 설정합니다 .
각 설정의 상세 사항들은 METAZAStudio 의 도움말을 참조 바랍니다 .  ( “Commands” > 
“[Object] 메뉴” > “Properties” > “[Properties] 대화상자” ).

""소프트웨어의 도움말을 보는 방법은 설치 가이드를 참조 바랍니다 .

I	설정 구성 후 ,[OK] 를 클릭합니다 .

가변 인쇄 데이터 만들기
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2 단계 : 가변 필드에 텍스트 넣기

순서

A	[Load CSV File] 을 클릭합니다 .
[Open...] 화면이 나타납니다 .
“Variable Printing ( 가변 인쇄 )” 화면이 나타나지 않으면 , 을 클릭합니다 .

B	CSV 파일을 선택한 후 [Open] 을 클릭합니다 .

선택한 CSV 파일을 METAZAStudio 로 가져옵니다 .

C	불러온 CSV 파일의 column ( 열 ) 제목을 가변 필드로 드래그합니다 .
가변 필드에 텍스트가 나타납니다 .

을 클릭하여 각 기호를 차례로 표시할 수 있습니다 . 가변의 크기 또는 위치를 변경하려면 , 
[Properties] 화면을 열어서 ( 클릭 ) 설정을 변경할 수 있습니다 .

가변 인쇄 데이터 만들기
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곡면에 인쇄하기

본 장비는 곡면에 인쇄가 가능합니다 . 본 장면은 아래의 반원통 소재를 예로 들어 곡면 인쇄 방법을 설
명합니다 .

50 mm (2.0 in.)10 mm 
(0.4 in.)지름  (ϕ)  

= 20 mm (0.8 in.)

중요 : 소재에 광흡수 필름과 포일을 부착합니다 .

평면의 소재보다 곡면의 소재가 광흡수 필름과 포일을 부착하기 어렵습니다 . 소재에 광흡수 필름과 
포일이 부착되지 않으면 포일은 성공적으로 전사되지 않습니다 . 따라서 필름 고정장치를 사용하여 
광흡수 필름과 포일을 소재에 견고히 부착합니다 .

1 단계 : 인쇄 영역 설정하기

먼저 소재의 인쇄 영역을 설정합니다 . 곡면에 인쇄할 경우 , 평면처럼 소재의 전체 표면에 인쇄할 수 없
습니다 . 이러한 이유로 METAZAStudio 편집화면에는 소재 대신 인쇄 영역이 표시됩니다 . 인쇄 영역
은 METAZA 드라이버 설정 화면에 입력된 소재의 지름 값에 의해 결정됩니다 .
곡면이 있는 소재에 인쇄할 수 있는 조건에 대한 자세한 정보는 아래의 페이지를 참조 바랍니다 .

"" P.15 “곡면 인쇄를 할 소재의 조건”

순서

A	[File] → [Preferences].
The [Preferences] 을 클릭합니다 .
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B	여백을 설정합니다 .

1	“Margin” 을 “0 mm” (0 in.) 로 설정합니다 .

2	[OK] 을 클릭합니다 .

메모

곡면에 인쇄할 경우 인쇄 가능한 영역이 제한됩니다 . 충분한 인쇄 영역을 확보하기 위해 여백을 0 mm 
(0 in.) 로 설정합니다 .

C	[File] → [Set up the printer] 을 클릭합니다 .
[Print Setup] 화면이 나타납니다 .

곡면에 인쇄하기
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D	프린터의 속성 화면을 엽니다 .

1	[DGSHAPE LD-80] 를 프린터 이름으로 선택했는지 확인합니다 .

2	[Properties] 을 클릭합니다 .

E	소재 크기 값을 입력합니다 .

1	[Material] 탭을 클릭합니다 .

2	지름을 입력합니다 .
본 예제에서는 20 mm (0.8 in.) 로 설정합니다 .

3	[Direction] 을 선택합니다 .
소재의 방향을 맞추기 위해 선택합니다 .

: 세로 : 가로

 In this example, select (vertical).

4	[Enter] 을 클릭합니다 .
[Work Size ( 작업 크기 )] 밑으로 , [Width ( 폭 )] 의 값이 자동으로 설정됩니다 . 본 예제에
서는 [Length ( 길이 )] 를 50 mm (2.0 in.) 로 설정합니다 .

5	[OK] 을 클릭합니다 .

곡면에 인쇄하기
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F	[OK] 을 클릭합니다 .

이것으로 인쇄 영역 설정이 완료됩니다 .

2 단계 : 소재 출력 영역에 가로로 쓰기

인쇄 영역을 정한 후 , 이미지와 텍스트를 영역 안에 배치합니다 . 본 장면에서는 세로 방향의 소재에 글
자를 가로로 입력하는 방법을 설명합니다 .

순서

A	첫번째 글자를 입력합니다 .

1	인쇄할 텍스트를 타입한 후 , 배치를 조정합니다 .

2	원하는 크기로 텍스트의 크기를 변경합니다 .
텍스트는 인쇄 영역에 맞아야 합니다 .

곡면에 인쇄하기
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B	입력한 글자를 회전시켜 세로로 만듭니다 .
"" P.58 “텍스트의 위치 , 크기 또는 각도 변경하기”

C	텍스트 입력을 위한 커서가 나타납니다 .

1	 을 클릭합니다 .

2	 키보드의 < → > key (left arrow key) 를 누릅니다 .
다음과 같은 결과가 나옵니다 .

D	나머지 텍스트를 입력한 후 , 텍스트를 원하는 위치로 이동시킵니다 .
"" P.54 “이미지의 위치 , 크기 또는 각도 조정하기”

곡면에 인쇄하기
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다양한 소재 등록하기

METAZAStudio 에는 사전 등록된 4 가지의 소재 모양이 포함되어 있습니다 . METAZAStudio 에 등
록되어있지 않은 소재에 인쇄하려면 새로운 소재를 등록합니다 . 이 등록은 인쇄 영역 제한과 렌즈가 소
재의 가장자리에 부딪혀서 손상되는 것을 방지합니다 . 
다음과 같은 3 가지 방법으로 소재를 등록할 수 있습니다 . 절차에 대한 자세한 정보는 METAZAStu-
dio 온라인 도움말을 참조 바랍니다 .

""소프트웨어의 도움말을 보는 방법은 설치 가이드를 참조 바랍니다 .

""와 ETAZAStudio 온라인 도움말 ( “Hints 와 Tips” > “즐겨찾는 소재 등록하기” )

비트맵 이미지 불러오기

소재와 동일한 크기의 이미지가 있는 경우 , 다음과 같은 조건에서 이미지를 불러올 수 있습니다 .
•	파일 포맷 : BMP (bitmap) 또는 JPEG

•	색상 : 바이너리 ( 검정과 흰색 )

•	소재에 해당하는 부분은 검은색으로 채워져 있어야 합니다 .

일반적인 스캐너로 소재 스캔하기

소재와 같은 모양의 이미지가 없거나 소재의 모양이 복잡할 경우 , 일반적인 스캐너로 소재를 스캔한 후 
그 스캔본을 불러올 수 있습니다 . 그럴 경우의 조건은 다음과 같습니다 .

•	스캐너 : TWAIN_32 를 지원하는 스캐너 .

•	색상 : 바이너리 ( 검정과 흰색—소재에 해당하는 부분은 검은색으로 채워져 있어야 합니다 )

소재 모양 그리기

소재가 정사각형 , 원형 또는 기타 단순 도형인 경우 , 드로잉 도구를 사용하여 단독으로 또는 도형을 조
합해서 모양을 그린 후 등록할 수 있습니다 .
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포일 등록 및 인쇄력 조정하기 

사용하는 소재의 포일에 맞는 인쇄력으로 인쇄를 하면 더 높은 품질의 인쇄 결과를 얻을 수 있습니다 . 
METAZA 드라이버에는 여러 포일에 적합한 설정이 사전 구성되어 있고 , 새로운 포일과 그에 맞는 최
적설정도 등록할 수 있습니다 . 더 나은 인쇄 결과를 위해 등록된 포일의 인쇄력도 조정 가능합니다 .

순서

A	[METAZA Driver Printing Preferences] 화면을 띄웁니다 .
"" [METAZA Driver Printing Preferences] 화면을 보는 방법은 설치 가이드를 참조 바랍니다 .

B	인쇄 모드를 선택합니다 .

1	[Image Correction] 탭을 클릭합니다 .

2	[Foil])] 옵셥을 하나 선택합니다 . (a 에서 d 까지의 옵션 ).

3	인쇄 모드로 [Text] 또는 [Others] 을 선택합니다 .

Text 외곽선이 선명한 텍스트나 기타 이미지를 인쇄하려면 이 옵션을 선택합니다 .

Other

해상도 기능 ( 또는 도트 해상도 ) 을 변경하여 도트의 농도 차이를 기반으로 표현
하고 싶거나 , 해상도를 높혀서 작은 텍스트나 패턴의 거칠기를 개선하고 싶은 경
우에 이 옵션을 선택합니다 . [Details] 을 클릭하여 , 이미지 해상도와 기타 설정
을 지정합니다 .

"" “ METAZA 드라이버 온라인 도움말 ("[Correction] tab")

4	[Details] 을 클릭합니다 .

[Details] 화면이 나타납니다 .
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C	상세 인쇄 모드 설정을 지정합니다 .

1	등록하려는 포일의 이름을 입력합니다 .

2	인쇄력과 속도를 입력합니다 .
인쇄 결과는 포일에 따라 다릅니다 . 포일에 맞게 조정합니다 .

""METAZA 드라이버 온라인 도움말 ([Correction] 탭 > [Details] 대화상자 )

Speed

인쇄 속도를 변경합니다 . 이미지 ( 래스터 ) 인쇄 속도는 지정된 값이 됩니다 . 라인 드로잉 
인쇄 속도의 상한은 24 mm/ 초 입니다 . 상한을 초과하는 속도를 지정하면 라인 드로잉 인
쇄 속도는 상한으로 설정되며 , 상한보다 작거나 같은 속도를 지정하면 라인 드로잉 인쇄 속
도는 지정된 값으로 설정됩니다 . 

Power--MIN 이미지의 가장 어두운 부분 ( 회색 부분 ) 의 인쇄력을 설정합니다 .

Power--MAX 이미지의 가장 밝은 부분 ( 흰색 부분 ) 의 인쇄력을 설정합니다 .

Vector--Power 라인의 인쇄력의 최대값을 설정합니다 .

3	[Advanced] 을 선택합니다 .

B단계의3 에서 [Others] 을 선택했을 경우에만 [Advanced] 을 선택할 수 있습니다 .
""METAZA 드라이버 온라인 도움말 ([Correction] 탭 > [Details] 대화상자 )

OutputResolution 1 인치당 도트의 수를 지정할 수 있습니다 . 포인트의 수가 커질수록 이미지가 더 선명해집
니다 .

Drafting
사진 이미지를 보기 쉽게 만들수 있도록 1 점 단위로 이미지 정보를 건너뛸 수 있습니다 . 정
보를 건너뛸 경우 , 작은 텍스트와 라인은 눈에 띄는 거칠기로 인쇄가 될 수 있습니다 . 이럴 
경우 , 이 옵션은 “OFF” 로 설정합니다 .

4	[OK] 을 클릭합니다 .

[Details] 화면이 종료됩니다 .

포일 등록 및 인쇄력 조정하기 

85제 4 장 상세 작동법 및 설정

LD-80_USE_Ko.indb   85 2018-08-19   오전 10:11:37



기본 드라이버 설정 변경하기

순서

A	프린터 아이콘을 표시합니다 .

Windows 10 및 8.1

1	컴퓨터의 [ 시작 ] 메뉴에서 마우스 오른쪽 버튼을 클릭하십시오 .

2	[ 제어판 ] 을 클릭합니다 .

3	[ 장치와 프린터 보기 ] 또는 [ 장치와 프린터 ] 를 클릭합니다 .
Windows 7

1	컴퓨터의 [ 시작 ] 메뉴를 클릭합니다 .

2	[ 장치와 프린터 ] 를 클릭합니다 .

B	[DGSHAPE LD-80] 아이콘의 오른쪽 버튼을 클릭한 후 , [ 프린트 설정 ] 을 클릭합니다 .
METAZA 드라이버를 위한 [ 프린트 설정 ] 화면이 나타납니다 . 필요에 따라 설정을 변경합니다 .

C	설정 변성 후 , [OK] 을 클릭합니다 .
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설명

METAZA 드라이버를 사용하면 소재의 크기와 디스플레이에 사용되는 단위 등 여러 항목의 기본 설정
을 변경 할 수 있습니다 . 앞에서 설명한 방법들로 설정된 기본 설정은 계속 사용됩니다 . 
METAZAStudio 에서 이 설정들을 변경할 수 있지만 변경 사항은 저장되지 않습니다 .

순서

[File] → [Print Setup] → [Properties] 을 클릭합니다 .
[METAZA Driver Printing Preferences] 화면이 나타납니다 . 필요에 맞게 설정을 변경합니다 .

기본 드라이버 설정 변경하기
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METAZAStudio 를 이용한 기타 작업

METAZAStudio 에는 다양한 기능이 포함되어 있습니다 .
자세한 조작 방법은 METAZAStudio 온라인 도움말을 참조 바랍니다 .

"" P.10 “소프트웨어 도움말 보기”
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문제해결하기

[Power/Movement] 버튼이 깜박일 때

전원을 켤때 헤드를 들어 올립니
까 ?

헤드가 올려져 있으면 소재의 표면 높이가 인쇄 요건을 충족시키
지 못 한다고 장비가 판단을 합니다 . 
[Power/Movement] 버튼을 1 초 이상 눌러서 전원을 끕니다 . 
전원을 켤 때 헤드를 불필요하게 만지지 않도록 주의합니다 .

렌즈가 장비에 올바르게 부착되어 
있습니까 ?

[Power/Movement] 버튼을 1 초 이상 눌러서 전원을 끕니다 . 
렌즈를 장비에 올바르게 부착하는 방법은 교체용 렌즈와 동봉된 
사용 설명서를 참조 바랍니다 .

인쇄 표면의 높이 변화가 너무 크
진 않습니까 ?

[Power/Movement] 버튼을 1 초 이상 눌러서 전원을 끕니다 . 
인쇄 소재의 조건을 확인한 후 , 소재를 다시 선택합니다 .

P.14 “소재 준비하기”

헤드가 잘 고정되어 있습니까 ?

노브를 풀어준 후 [Power/Movement] 버튼을 누릅니다 . 오류
가 해제되고 전원 램프가 점등됩니다 .

노브
풀어줍니다

인쇄 데이터를 보내도 장비가 작동하지 않을 때

전원은 켜져 있습니까 ?

Power/Movement( 전원 / 이동 ) 버튼이 점등되어 있는지 확
인합니다 . 꺼져 있는 경우 , 버튼은 눌러 전원을 켭니다 .

P.9 “전원 켜기”

전원선은 올바르게 연결되어 있습
니까 ?

올바르게 연결되어 있지 않으면 연결합니다 .

본체와 컴퓨터를 연결하는 방법은 설치 가이드를 참조 바랍니다 .

컴퓨터 연결선은 올바르게 연결되
어 있습니까 ?

케이블 연결이 해제되어 있지 않은지 확인합니다 .
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METAZAStudio 로 Foil ( 포일 ) 선택이 안 될 때

[Use printer driver settings] 
체크 박스가 선택되어 있습니까 ?

METAZAStudio 가 시작된 직후에 표시되는 [Select Foil] 화면
에서 [Use printer driver settings] 체크 박스가 선택되어 있으
면 포일을 선택할 수 없습니다 . [Use printer driver settings] 
체크 박스를 해제합니다 .

METAZAStudio 의 이전 버전을 
사용하고 있습니까 ?

2.30 이전의 METAZAStudio 버전은 LD-80 를 지원하지 않기 
때문에 포일을 선택할 수 없습니다 . METAZAStudio 의 최신 버
전을 설치합니다 .

인쇄된 위치가 원하던 곳이 아닐 때

소재가 올바른 위치에 고정되어 
있습니까 ?

소재가 센터 바이스 또는 그리드 테이블에 올바르게 고정되어 있
는지 확인합니다 . 또한 레이저 포인터가 소재의 중앙에 위치해있
는지 확인하고 필요하면 위치를 조정합니다 .

P.28 “소재 고정하기 ( 센터 바이스 사용 )”

P.32 “소재 고정하기 ( 그리드 테이블  사용 )”

레이저가 타겟에 조사되지만 아무
것도 인쇄되지 않습니다 .

본 장비로 인쇄할 수 있는 조건을 충족하는 소재입니까 ?
인쇄가 가능한 소재를 준비해서 사용하십시오 .

P.14 “소재 준비하기”

장비의 원점이 맞지 않습니까 ?

원점이 맞지 않는다면 원하는 위치에 텍스트와 이미지를 인쇄할 
수 없습니다 . LD-80 헤드매니저로 원점을 조정합니다 .

P.44 “Origin Location ( 원점 위치 ) 조정하기”

광흡수 필름의 반대 면이 프레임
에 부착되어 있습니까 ?

광흡수 필름의 반대 면이 프레임에 부착되어 있으면 인쇄가 되지 
않습니다 . 광흡수 필름을 처음 설치할 때와 교체할 때 , 방향을 맞
춰서 부착합니다 .

P.47 “Light-absorbing Film ( 광흡수 필름 ) 교체하기”

포일의 앞면과 뒷면이 거꾸로 되
어 있습니까 ?

소재에 인쇄할 포일색이 위를 향하게 놓습니다 .

헤드가 고정되어 있습니까 ?

헤드가 고정되어 있으면 렌즈가 소재와 접촉하지 않은채로 인쇄
가 되어서 예상하던 인쇄가 불가능할 수 있습니다 . 노브를 풀어준 
상태로 인쇄합니다 .

노브
풀어줍니다

문제해결하기
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인쇄된 이미지가 보기 안 좋을 때 ( 울퉁불퉁하거나 위치가 움직였을 때 )

포일 설정이 올바르게 되어 있습
니까 ?

METAZAStudio 에서 사용할 포일을 선택합니다 . 같은 포일도 
표면 상태에 따라 인쇄 조건이 다를 수 있습니다 . 이럴 경우 세밀
한 인쇄력 조정이 필요합니다 .

P.84 “Foil ( 포일 ) 등록 및 인쇄력 조정하기”

P.19 “1 단계 : 소재의 모양과 크기 정하기” B단계 참조

렌즈의 서비스 수명이 끝났습니
까 ?

LD-80 헤드매니저로 렌즈 상태를 확인할 수 있습니다 . 렌즈 사
용 표시기가 빨간색이면 새 렌즈로 교체합니다 .

P.46 “렌즈 상태 확인하기”

양방향 인쇄를 했습니까 ?

양방향 인쇄는 인쇄 시간을 단축시키지만 이미지 품질이 저하
될 수 있습니다 . 이럴 경우 METAZA 드라이버 설정 화면에서 
[Bidirection ( 양방향 )] 설정을 해제한 후 다시 인쇄합니다 .

METAZA 드라이버 온라인 도움말 ("[Material] 탭 ")

광흡수 필름의 위치를 이동시켜 
인쇄를 할 수 있습니까 ?

광흡수 필름의 같은 위치를 여러번 사용하면 깔끔한 인쇄를 할 수 
없습니다 . 필름에 여러번 사용된 위치와 한번도 사용되지 않은 위
치가 있다면 고르지 못한 인쇄가 될 수 있습니다 . 
인쇄 범위에 사용되지 않은 부분이 놓이게 광흡수 필름의 위치를 
이동시킨 후 다시 인쇄합니다 .

P.48 “Light-absorbing Film ( 광흡수 필름 ) 교체 방법”

헤드가 고정되어 있습니까 ?

헤드가 인쇄 도중에 고정이 되면 렌즈가 소재와 접촉하지 않은채
로 인쇄가 되어서 예상하던 인쇄가 불가능할 수 있습니다 . 노브를 
풀어준 상태로 인쇄합니다 .

노브
풀어줍니다

문제해결하기
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인쇄된 이미지가 항상 같은 위치만 누락되었을 때

인쇄 표면 높이의 변화가 너무 크
진 않습니까 ?

인쇄 표면 높이의 변화가 너무 클 수 있습니다 . 장비로 인쇄할 수 
있는 소재의 조건들을 다시 확인하고 조건에 맞는 소재를 선택합
니다 .

P.14 “소재 준비하기”

광흡수 필름이 사용되는 위치를 
이동시켜 인쇄할 수 있습니까 ?

광흡수 필름에서 같은 위치를 여러번 사용하면 깔끔히 인쇄할 수 
없습니다 . 사용되지 않은 위치로 인쇄 범위를 덮을 수 있도록 광
흡수 필름을 이동시킨 후 , 다시 인쇄합니다 .

P.48 “Light-absorbing Film ( 광흡수 필름 ) 교체 방법”

인쇄할 위치 밖에 있는 불필요한 Foil ( 포일 ) 은 제거해야 합니다 .

포일이 의도하지 않았던 위치에 있을 때에는 셀로판 테이프를 사용하여 불필요한 포일을 제거합니다 .

드라이버를 별도로 설치하기

METAZA 드라이버와 소프트웨어를 같이 설치할 수 있습니다 . 함께 설치하려면 설치 가이드를 참조 바
랍니다 .

순서

A	윈도우에서 관리자 또는 관리자 그룹으로 로그인합니다 .

B	DGSHAPE 소프트웨어 패키지 CD 를 컴퓨터의 CD-ROM 드라이브에 넣습니다 .
자동 재생 화면이 나타나면 [Run menu.exe] 을 클릭합니다 . 설치 메뉴가 자동으로 나타납니다 .

C	METAZA 드라이버가 설치되어 있다면 제거합니다 .
"" P.99 “드라이버 제거하기”

드라이버가 설치되어 있지 않거나 제거되었다면  D단계로 넘어갑니다 .

D	[Custom Install] 을 클릭합니다 .

문제해결하기
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E	METAZA 드라이버에서 [Install] 을 클릭합니다 .

F	[Install] 을 선택한 후 , 모델명으로 [DGSHAPE LD-80] 를 , 포트로 [USB] 를 선택하

고 [Start ] 을 클릭합니다 ..

METAZA 드라이버 설치가 시작됩니다 . 화면에 나오는 지시를 따라 진행합니다 .
화면이 나타나면 [Install] 을 클릭합니다 .

G	이 화면이 나타나면 [Finish] 을 클릭합니다 .

문제해결하기
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H	설정 메뉴 화면에 있는  을 클릭합니다 .

I	CD-ROM 드라이브에서 CD 를 꺼냅니다 .

J	USB 케이블을 사용해서 장비와 컴퓨터를 연결합니다 .
동봉된 USB 케이블을 사용하고 USB 허브는 사용하지 마십시오 .

METAZA 드라이버가 자동으로 설치됩니다 .

소프트웨어와 전자 사용 설명서를 별도로 설치하기 

순서

A	윈도우에서 관리자 또는 관리자 그룹으로 로그인합니다 .

B	DGSHAPE 소프트웨어 패키지 CD 를 컴퓨터의 CD-ROM 드라이브에 넣습니다 .
자동 재생 화면이 나타나면 [Run menu.exe] 을 클릭합니다 . 설치 메뉴가 자동으로 나타납니다 .

C	[Custom Install] 을 클릭합니다 .

문제해결하기
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D	설치하고 싶은 프로그램이나 전자 사용 설명서에서 [Install] 을 클릭합니다 .

METAZA 드라이버 설치는  P.93 “드라이버를 별도로 설치하기” 를 참조 하기 바랍니다 .

E	메세지들을 따라 소프트웨어를 설치합니다 .
[User Account Control] 화면이 나타나면 [Allow] 을 클릭하여 , 소프트웨어를 설치합니다 .

F	설치가 완료되면 설정 메뉴 화면에 있는  을 클릭합니다 .

G	CD-ROM 드라이브에서 CD 를 꺼냅니다 .

드라이버 설치가 불가능할 때

설치가 중간에 끊기거나 USB 케이블을 연결했을 때 설치 마법사가 나타나지 않았다면 METAZA 드라
이버가 설치되지 않았을 수 있습니다 . 이런 경우에는 아래 단계를 수행합니다 . (A 단계로 문제를 해결
하지 못 했다면  B 단계를 수행합니다 .)

Windows 10/8.1 (A 단계 )

순서

A	USB 케이블로 장비와 컴퓨터를 연결하고 장비의 전원을 켭니다 .

B	[Desktop] 을 클릭합니다 .

C	[ 시작 ] 에서 마우스 오른쪽 버튼으로 클릭한후 ,[ 제어판 ] 을 클릭합니다 .

문제해결하기
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D	[ 장치와 프린터 보기 ] 또는 [ 장치와 프린터 ] 를 클릭합니다 .

E	사용 중인 모델이 “Unspecified” 으로 표시되는지 확인합니다 .

F	사용 중인 모델의 아이콘에서 마우스 오른쪽 버튼을 클릭한후 [Remove device] 를 클릭

합니다 .

G	"Are you sure you want to remove this device?" 라는 메세지가 나타나면 , [Yes] 를 

클릭합니다 .

H	사용 중인 모델이 “Unspecified” 로 표시되지 않는지 확인합니다 .

I	장비와 컴퓨터를 연결하는 USB 케이블을 잠시 해제하고 다시 연결합니다 . 윈도우 드라이

버가 성공적으로 설치되면 사용 중인 장비의 프린터 아이콘이 “Printer” 에 표시됩니다 .

J	만약 문제가 해결되지 않았다면 “Windows 10/8.1 (B 단계 )” 를 수행합니다

Windows 10/8.1 (B 단계 )

순서

A	USB 케이블로 장비와 컴퓨터를 연결하고 장비의 전원을 켭니다 .

B	[Found New Hardware] 화면이 나타나면 [Cancel] 을 클릭하여 창을 닫습니다 . 본 장

비를 제외한 다른 프린터와의 USB 케이블 연결을 해제합니다 .

C	[Desktop] 을 클릭합니다 .

D	[ 시작 ] 에서 마우스 오른쪽 버튼을 클릭한 한 후 [ 장치 매니저 ] 를 클릭합니다 .

E	[ 사용자 계정 제어 ] 화면이 나타나면 [ 계속 ] 을 클릭합니다 . [ 장치 매니저 ] 가 나타납

니다 .

F	[ 보기 ] 메뉴에서 [ 숨은 장치 보기 ] 를 클릭합니다 .

G	목록에서 [ 프린터 ] 또는 [ 다른 장치 ] 를 찾아 더블 클릭합니다 . 모델 이름 또는 [ 알 수 

없는 장치 ] 를 클릭합니다 .

H	[Action] 메뉴에서 [Uninstall] 를 클릭합니다 .

I	“장치 제거 확인” 화면에서 [OK] 를 클릭합니다 . [ 장치 매니저 ] 창을 닫습니다 .

J	컴퓨터에서 USB 케이블을 해제한 후 , 윈도우를 다시 시작합니다 .

K	윈도우 드라이버를 제거합니다 . P.99 “Windows 10/8.1” 에 명시되어 있는 3 단계에 따라 드라

이버를 제거합니다 ..

L	“설치 가이드 ” ( “소프트웨어 설치하기” ) 또는 P.93 “드라이버를 별도로 설치하기” 에 명시되어 있

는 단계대로 드라이버를 재설치합니다 .

문제해결하기
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Windows 7 (A 단계 )

순서

A	USB 케이블로 장비와 컴퓨터를 연결하고 장비의 전원을 켭니다 .

B	[ 시작 ] 메뉴를 클릭하고 , [ 장치와 프린터 ] 를 클릭합니다 .

C	사용 중인 모델이 “Unspecified” 으로 표시되는지 확인합니다 .

D	사용 중인 모델의 아이콘의 마우스 오른쪽 버튼을 클릭한 후 , [Troubleshooting] 을 클

릭합니다 .

E	"Install a driver for this device" 라는 메세지의 화면이 나타나면 [Apply this fix] 를 클

릭합니다 .

F	“Set as default printer” 라는 메세지가 나타나면 ,[Skip this fix] 를 클릭합니다 .

G	“Troubleshooting has completed” 라는 메세지가 나타나면 , [Close the trouble-

shooter] 을 클릭합니다 .
윈도우 드라이버가 성공적으로 설치되면 사용 중인 장비의 프린터 아이콘이 “Printer” 에 표시됩니다 . 
만약 문제가 해결되지 않았다면 아래의 “Windows 7 (B 단계 )” 를 수행합니다 .

Windows 7 (B 단계 )

A	[ 새로운 하드웨어 발견 ] 화면이 나타나면 , [Cancel] 을 클릭하여 창을 닫습니다 .

B	[ 시작 ] 메뉴에서 , [ 컴퓨터 ] 마우스 오른쪽 버튼을 클릭합니다 . [ 속성 ] 을 클릭합니다 .

C	[ 장치 매니저 ] 를 클릭합니다 . [ 사용자 계정 제어 ] 화면이 나타나면 [ 계속 ] 을 클릭합

니다 . [ 장치 매니저 ] 가 나타납니다 .

D	[View] 메뉴에서 ,[Show hidden devices] 를 클릭합니다 .

E	목록에서 [Other devices ( 다른 장치 )] 를 찾아 더블클릭합니다 . 모델 이름 또는 [Un-

known device ( 알 수 없는 장치 )] 를 클릭합니다 .

F	[Action] 메뉴에서 , [Uninstall] 을 클릭합니다 .

G	“Confirm Device Uninstall” 화면에서 , [Delete the driver software for this de-

vice.] 를 클릭한 후 , [OK] 를 클릭합니다 . [Device Manager] 를 닫습니다 .

H	컴퓨터에서 USB 케이블을 해제한 후 , 윈도우를 다시 시작합니다 .

I	윈도우 드라이버를 제거합니다 . P.100 “Windows 7” 에 명시되어 있는 3 단계에 따라 드라이버

를 제거합니다 .

문제해결하기
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J	“설치 가이드 ” ( “소프트웨어 설치하기” ) 또는 P.93 “드라이버를 별도로 설치하기” 에 명시되어 있

는 단계대로 드라이버를 재설치합니다 .

드라이버 제거하기

METAZA 드라이버의 제거는 다음과 같은 단계로 진행합니다 .

Windows 10/8.1

순서

* 아래의 단계를 따르지 않고 드라이버를 제거하면 재설치가 불가능할 수도 있습니다 .

A	장비의 전원을 끈 후 , 장비와 컴퓨터 사이의 연결선을 해제합니다 .

B	윈도우에서 관리자로 로그인합니다 .

C	[Desktop] 을 클릭합니다 .

D	[ 시작 ] 에서 마우스 오른쪽 버튼으로 클릭한후 ,[ 제어판 ] 을 클릭합니다 .

E	[Uninstall a program] 또는 [Programs and Features] 을 클릭합니다 .

F	삭제할 장비의 윈도우 드라이버를 클릭하여 , 선택한 후 [Uninstall] 를 클릭합니다 . 

[User Account Control] 화면이 나타나면 ,[Allow] 을 클릭합니다 .

G	삭제를 확인하는 메세지가 나타나면 , [Yes] 을 클릭합니다 .

H	[ 시작 ] 을 클릭한 후 , [ 데스크탑 ] 을 클릭합니다 .

I	익스플로러를 열고 윈도우 드라이버가 들어있는 드라이브와 폴더를 엽니다 . (*)

J	“SETUP64.EXE” (64-bit 버전 ) 또는 “SETUP.EXE” (32-bit 버전 ) 을 더블클릭합니

다 .

K	[User Account Control] 화면이 나타나면 , [Allow] 을 클릭합니다 . 윈도우 드라이버를 

위한 설정 프로그램이 시작됩니다 .

L	[Uninstall] 을 클릭합니다 . 제거할 장비를 선택한 후 [ 시작 ] 을 클릭합니다 .

M	컴퓨터를 다시 시작 하면 시작 화면이 나타납니다 . [Yes] 을 클릭합니다 .

N	검퓨터가 다시 시작되면 다시 제어판을 열고  [ 장치와 프린터 보기 ] 또는 [ 장치와 프린터 ]

를 클릭합니다 .

문제해결하기
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O	제거할 장비의 아이콘에서 마우스 오른쪽 버튼을 클릭한후 ,[ 장치 제거하기 ] 를 클릭합니

다 .(*)
CD-ROM 을 사용할 때는 아래와 같이 폴더를 지정합니다 . (CD-ROM 드라이브가 D 드라이브라는 
가정하에 )
D: \Drivers\WINX64 (64-bit 버전 )
D: \Drivers\WINX86 (32-bit 버전 )
DGSHAPE 소프트웨어 패키지 CD 를 사용하지 않을 경우에는 DGSHAPE Corporation 웹사이트  
(http://www.dgshape.com/) 에서 제거하고 싶은 장비의 Windows 드라이버를 다운받은 후 , 다
운받은 파일을 추출할 폴더를 지정합니다 .

Windows 7

순서

* 아래의 단계를 따르지 않고 드라이버를 제거하면 재설치가 불가능할 수도 있습니다 .

A	드라이버를 제거하기 전 , 컴퓨터에 연결된 USB 케이블을 해제합니다 .

B	윈도우에서 관리자로 로그인합니다 .

C	[ 시작 ] 메뉴에서 [ 제어판 ] 을 클릭합니다 . [Uninstall a program] 또는 [Programs 

and Features] 을 클릭합니다 .

D	삭제할 장비의 윈도우 드라이버를 클릭하여 선택한 후 , [Uninstall] 을 클릭합니다 .

E	삭제를 확인하는 메세지가 나타나면 , [Yes] 을 클릭합니다 .

F	Taskbar ( 태스크 바 ) 에서 [Start], [All Programs], [Accessories], [Run], 

[Browse] 를 클릭합니다 .

G	윈도우 드라이버가 있는 드라이브 또는 폴더의 이름을 선택합니다 . (*)

H	“SETUP64.EXE” (64-bit 버전 ) 또는 “SETUP.EXE” (32-bit version) 을 선택하고 

,[Open] 을 클릭한 후 , [OK] 을 클릭합니다 .

I	[User Account Control] 화면이 나타나면 ,[Allow] 을 클릭합니다 .

J	윈도우 드라이버를 위한 설정 프로그램이 시작됩니다 .

K	[Uninstall] 을 클릭합니다 . 제거할 장비를 선택한 후 [Start] 을 클릭합니다 .

L	컴퓨터를 다시 시작해야 하면 다시 시작 화면이 나타납니다 . [Yes] 을 클릭합니다 .

문제해결하기
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M	컴퓨터가 다시 시작되면 제거가 완료됩니다 .(*)

CD-ROM 을 사용할 때는 아래와 같이 폴더를 지정합니다 . (CD-ROM 드라이브가 D 드라이브라는 
가정하에 )
D: \Drivers\WINX64 (64-bit 버전 )
D: \Drivers\WINX86 (32-bit 버전 )
DGSHAPE 소프트웨어 패키지 CD 를 사용하지 않을 경우에는 DGSHAPE Corporation 웹사이트  
(http://www.dgshape.com/) 에서 제거하고 싶은 장비의 Windows 드라이버를 다운받은 후 , 다
운받은 파일을 추출할 폴더를 지정합니다 .

문제해결하기
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장비 이동

중요 !

장비를 옮길 때는 반드시 아래와 같이 제거 / 설치 단계를 수행해야 합니다 . 그렇지 않을 경우 , 장비에 
손상을 입힐 수 있습니다 .

1 단계 : 장비로부터 고정장치 제거하기

순서

A	전원이 꺼져 있는지 확인합니다 .

B	장비의 커버를 엽니다 .

C	설치된 그리드 테이블이나 센터 바이스를 제거합니다 .
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D	캡 나사를 풉니다 .

풀어줍니다

E	필름 고정장치에서 필름 프레임을 제거합니다 .
이 부분을 본인 방향으로 당깁니다 .

F	캡 나사를 제거합니다 .

장비 이동
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G	장비에서 필름 고정장치를 제거합니다 .

필름 고정장치

장비 이동
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2 단계 : 고정장치 설치하기 	

고정장치의 저장 위치는 설치 가이드를 참조 바랍니다 .

순서

A	전원이 꺼진 상태로 Power/Movement 버튼을 10 초 이상 누릅니다 .
아래와 같이 헤드가 움직입니다 .
	

B	전원선과 USB 케이블을 제거합니다 .

C	헤드를 가장 높은 위치로 올리고 노브로 고정시킵니다 .

장비 이동
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D	고정장치를 부착합니다 .
고정장치와 나사로 세 군데를 고정합니다 . 모든 고정장치를 부착하고 동봉된 육각 렌치로 나사를 
조입니다 . 고정장치와 나사의 저장 위치는 설치 가이드를 참조 바랍니다 .

사용되는 도구 고정장치

육각 렌치 고정장치 (2) 캡 나사 ( 고정장치와 사용 ; 5)

E	장비의 커버를 닫습니다 .

F	장비를 재포장합니다 .
장비를 이동시킬 때는 반드시 두손으로 바닥을 받치고 움직입니다 . 다른 곳을 잡고 이동시키면 파
손의 위험이 있습니다 .

장비 이동
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센터 바이스 사양

고정할 수 있는 소재의 최고 폭은  50 mm (2.0 in.) 입니다 .
크기에 맞춰서 방향을 바꾼 후 소재를 놓습니다 .

120 mm (4.7 in.)

50 mm 
(2.0 in.)

93.5 mm 
(3.7 in.)

인쇄 영역

최대 인쇄 영역과 권장 인쇄 영역

중앙선

중앙선

  그리드 테이블의 상면도

80 mm (3.2 in.)

50 mm 
(2.0 in.)

50 mm 
(2.0 in.)

80 mm 
(3.2 in.)

권장 인쇄 영역

(50 mm × 50 mm (2.0 in. × 2.0 in.))

인쇄가 불가능한 영역 (5 mm

× 10 mm  [0.2 in. × 0.4 in.])

안전상 인쇄가 불가능합니다 . 

최대 인쇄 영역 (80 mm × 80  mm 

(3.2 in. × 3.2 in.))

반드시 METAZA 드라이버로 설정해야 합니다 . 

이미지가 권장 인쇄 영역을 벗어나면 인쇄 결과가

고르지 않을 수 있습니다 . 

본체 사양
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전력 등급과 일련번호의 위치

전력 등급
여기에 주어진 전압 , 주파수와 암페어 조건을 충족하
는 콘센트를 사용합니다 .

뒷면

일련번호
유지 보수 , 서비스 또는 지원을 요청할 때 필요한 정
보입니다 . 절대 레이블을 벗기거나 더럽히지 마십
시오 .

전력 등급
여기에 주어진 전압 , 주파수와 암페어 조건을 충족
하는 콘센트를 사용합니다 .

AC 어댑터

본체 사양
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제품사양

LD-80

인쇄 가능한 소재 아크릴 , 폴리카보네이트 , 폴리프로필렌 , 폴리스티렌 , ABS

고정 가능한 소재의 크기 최대 100 mm ( 폭 ) × 200 mm ( 길이 ) × 20 mm ( 두께 ) (3.9 in. × 7.9 in. × 0.8 in.)
또는 180 mm ( 폭 ) × 100 mm ( 길이 ) × 20 mm ( 두께 ) (7.1 in. × 3.9 in. × 0.8 in.)

"" P.107 “인쇄 영역”

인쇄 영역 최대 인쇄 가능 영역 80 mm ( 폭 ) × 80 mm ( 깊이 ) (3.1 in. × 3.1 in.)

권장 인쇄 영역 50 mm ( 폭 ) × 50 mm ( 깊이 ) (2.0 in. × 2.0 in.)

해상도 353 dpi ( 텍스트 ), 1058 dpi ( 벡터 )

인쇄 방향 단방향 인쇄 또는 양방향 인쇄 ( 윈도우 드라이버로 선택 가능 )

인쇄 속도 ( 기본 ) 24 mm/s (0.94 in./s)

인터페이스 USB

전력 요구사항 전용 AC 아답터 AC 100 to 240 V ± 10%, 50/60 Hz

장비 DC 19 V 1.0A

전력 소비 약 . 14 W

작동 소음 70 dB (A) 이하

작동 온도 10 ~ 30° C (50 ~ 86° F)

작동 습도 35 ~ 80% ( 무결로 )

외형 치수 286 mm ( 폭 ) × 383 mm ( 깊이 ) × 308 mm ( 높이 ) (11.3 in. ( 폭 ) × 15.1 in. ( 깊이 ) 
× 12.2 in. ( 높이 ))

무게 12 kg (26.5 lb.)

광원 인쇄용 ( 포일 전사 ) 클래스 4 레이저 ; 파장 : 450 nm; 분산 : 23 도 ; 펄스 폭과 반복성 : 
167.5 μ s, 4 kHz;  최대 출력 : 1.6 W

위치용 클래스 1 레이저 , 파동 : 655 nm

안전장치 연동 커버가 열리면 레이저 전력 공급 장치가 꺼집니다 .

커버 차광 커버

포함된 물품 AC 아답터 , 전원선 , USB 케이블 , 소프트웨어 패키지 CD, 설치 가이드 , 소재 고정장치 , 등 .

본체 사양
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USB 연결을 위한 시스템 사양

컴퓨터 Windows 10, 8.1, 또는 7 (32- or 64-bit) 가 설치되어 있는 모델 , 또는 기존에 
Windows 7 또는 이후의 운영체제가 설치되어 있었던 업그레이드 된 컴퓨터

USB 케이블 동봉된 USB 케이블을 사용하십시오 .

본체 사양
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